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The purpose of this manual, as prescribed by the grant application, is to provide specifications for digitization capture and
file creation; procedures for digitization, file editing, and linking; and a detailed timeline for production goals and
management tasks. It gets updated as necessary as the project evolves.

The project workflows include:
1. Physical condition review
2. Scanning
a. Epson
b. Bookeye
c. Further guidance for in-house scanning
d. Microfilm scanning by vendor
3. Scanned image review
a. In-house images
b. Vendor-supplied microfilm images
4. Image management
a. Storage
b. LZW compression
c. Image enhancement in Photoshop
d. PDF creation
i. Standard
ii. Oversize
Uploading & Digital Object creation
6. Scanner maintenance
a. Cleaning
b. Calibration

U

Project workflow description

1. Physical condition review
The Project Supervisor [PS] reviews folder contents for physical condition and arrangement and addresses
preservation challenges that affect scanning. The bulk of this process comprises flattening documents and correcting
errors in arrangement. An item count is also performed at this stage for later comparison with scan counts.
Microfilm reels are randomly reviewed for quality and completeness before being sent to a vendor for digitization.

2. Scanning
Student scanning technicians perform in-house scanning for the project, using an Epson Expression 10000XL flatbed
scanner and a Bookeye 4 Basic planetary scanner. Digitization of collection microfilm is outsourced to a vendor.
a. Epson scanning instructions
i. Turn on scanner, then open SilverFast software
ii. Scan settings
1. Scan Type: 48-> 24 Bit Color
2. Scale% should both read 100.0
3. 400 dpi
iii. Document placement
1. One side of the document is to be placed against the spacer taped to the left side of the scanner
bed. The top (or side) edge of the document should be located at the black hash mark on the
spacer.

iv. Inthe SilverFast “Name” field, enter the file name for the image being scanned, using a naming
convention that reflects the hierarchy of the processed collection. All file names will end with “r” or “v”
for “recto” and “verso.”

1. Single sheetitems



a.
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The file name for the recto side of the first item in the first folder of the first box of the
collection is created by combining the collection number with those filing elements:
M092b001f001i001r.

2. Multi-sheet items

a.

The file names for multi-sheet items receive work-letter suffixes as necessary:
M092b001f001i001ar, ...001av, ...001br, ...001bv, etc.

Certain multi-sheet items in the collections are so long as to make it impractical to assign
a letter to each sheet (e.g. 100+ page articles). For these items, each sheet was numbered
individually without letters using the single sheet item naming convention (see above).

v. Click “Prescan.”

1. Check prescanned image for folds or other issues, then adjust the document as necessary and

prescan again. Rotate image as necessary.

2. Use the marquee to select the scan area. Leave a narrow margin of white space around the edges

of the document and include the ruler in your scan.

vi. Click “Scan.”

1. Inthe “Save As” box that appears, ensure “Save as type” is TIFF, then click “Save.”

b. Bookeye scanning instructions for loose and bound volumes
i. Turn on scanner, then open FreeFlow software.
ii. Open or create object
1. To starta folder

a.

b.

Click “New.” For “Project,” enter OOH. For “Object name” enter the file name, using a
naming convention that reflects the hierarchy of the processed collection.
i. The file name for the first folder in the first box of the collection is created by
combining the collection number with those filing elements: M090b001f001
Click “OK.”

2. To continue a folder in progress

a.

Click “Manage.” Select the object corresponding to the folder being scanned, and click
“Open Existing Object.”

iii. Under “Full Settings,” click the “Setup” button and load settings template
1. “OOH_loose” for loose paper scanning
2. “BookVplatenTIFF400” for bound volume scanning

iv. Placement

1. Loose papers

a.
b.

Place ruler next to document, as close as possible without overlapping.
Ensure the red laser line is within the bottom 1/3 of the document. Pressing the power
button will cause the laser line to appear for 10 seconds.

2. Bound volumes

a.

Rest the volume on the book cradle, sliding the sides of the cradle to account for the
volume’s size.
Ensure the red laser line is on the bottom 1/3 of the volume.
As needed, place shims under the cover for support. These will need to be adjusted
throughout the scanning of a single volume.
Position the glass platen
i. Lower the platen using the front handle until it is just above the volume. Wipe
both sides of the glass platen clean of dust and lint with a soft cloth (repeat this
cleaning after every 100 scans or as needed).



V.

vi.
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ii. Using the silver handle at the back of the platen, slide the platen left and right so
that its center is directly over the volume’s gutter.

iii. Snugly position the platen against the volume by pressing down firmly on both
the back and front handles. If positioned correctly, both sides of the glass should
be resting against the pages being scanned, and the gutter and the “V” joint should
nest together in parallel.

iv. Confirm that the outer edges of the volume are in contact (or nearly) with the
platen.

Click “Scan”
1. Ensure scanned image has captured the entire document or page spread. If the scan is
unsatisfactory, reposition the document as necessary and scan again, using the “Replace Current
Image” function.
Image Treatment & Export
1. For bound volumes, do not perform Image Treatment or Export [completed later by PS]
2. Forloose papers, when a folder is finished, proceed to the Image Treatment tab. For each image
individually, perform necessary cropping and rotation.

a. Rotate images (90° or 180°) with curved arrow buttons on the right side of the Image
Treatment screen.

b. To crop, create and adjust content clips around each sheet, leaving a narrow margin
around the document. Access the content clip tool through the tool bar the top of the
Image Treatment screen. Content clips can also be used to account for skew, but this
generally should not be necessary.

c. Click “Perform IT on All Images.” Once this process is finished, the Export tab will
automatically open.

i. Ensure Image Treatment functioned properly for each image.
d. Click “Export Images”
i. Load export settings template “OOH_loose”
ii. Under Choose Base Output Directory, browse to the appropriate folder (e.g.
OOHscans\Box02\folder003)
iii. Click “OK.” Wait for green check next to TIFF progress bar, then click “Close.”

c. Guidance on scanning various attachments, etc., for in-house scanning

.

il.

iii.

iv.

V.
vi.
Vii.
viil.
ix.
X.
Xi.
Xii.

Transcripts: Scan a transcript immediately after the document it transcribes. Do not scan the blank
verso of a transcript.

News clippings: Scan both sides of news clippings if possible. If not glued to document, scan a clipping
immediately after the document with which it is associated. If you have trouble getting the Bookeye to
capture a news clipping, try using a white background.

Items glued to a document: If glued item can be easily, *GENTLY* folded back, scan without folding it
first, then scan with glued item folded back. Please ask for assistance if needed.

Documents in mylar sleeves: Carefully remove document for scanning and replace in sleeve afterward.
Ask for assistance if needed.

Photocopies/printed scans: Leave in place but do not scan.

Exhibit description cards: Leave in place but do not scan.

“Wrong place” notes: Leave in place but do not scan.

Blank white pieces of paper: Leave in place but do not scan.

Large ink stains: Use extra care. Wipe down scanner and wash hands after scanning stained document.
Translucent paper: Use a white background in order to ensure a legible scan.

Envelopes: Scan an envelope with the first sheet of its contents (recto and verso, respectively).

Notes indicating the location of out-of-place items: Usually written in pencil on acid-free paper. Scan
only sides with writing on them (usually just the recto).

d. Microfilm scanning by vendor



Oliver Otis Howard Papers Digitization Project Manual
Updated 03/2017

i. Vendor is supplied with image specifications and naming conventions as part of the shipment of
microfilm reels (use negatives) and a blank external hard drive. Vendor performs digitization, contacting
PS with any questions or concerns, then returns microfilm and hard drive containing scanned images.

3. Scanned image review
The PS reviews all scanned images in preparation for their compression and combination to ensure image quality
and proper sequencing, and to verify that no items were overlooked in the scanning process.
a. Review of images scanned in-house
i. Special care is taken to check in frequently on the work of each individual student, especially during their
first weeks as scanning technicians.
ii. Using Windows Photo Viewer, images are checked quickly for image quality (margin, orientation, folds)
iii. Contents of physical folders are compared to digital ones to ensure that no documents were overlooked.
File names are checked, ensuring they follow the established naming convention and that each sheet has
associated recto and verso files
b. Review of vendor-supplied microfilm images
i. Proper file hierarchy and conformance to naming convention are ensured
ii. Images are checked for completeness and quality
iii. When it appears a digitization error has been made, images are checked against microfilm frames
iv. Any errors are corrected by the vendor

4. Image management
Note: The FreeFlow export process creates extraneous folders that need to be deleted by the PS.
a. Storage
i. Digital storage structure
1. Prior to assigning each reviewed folder to a scanning technician, the PS creates and names
computer folders and subfolders to provide prescribed storage locations for saving the scans on
College servers. Folder structure and naming convention: Box01\folder001\
b. LZW compression of TIFFs (Photoshop)
Once images in a folder have been reviewed, the PS compresses them using a batch process in Photoshop. The
workflow is as follows.
Note: LZW compression of images is only necessary on those scanned using the Epson scanner, since the
FreeFlow software used with the Bookeye scanner performs LZW compression automatically upon export.
i. File->Scripts=>Image Processor
1. Select appropriate folder
2. Save in Same Location
3. Save as TIFF with LZW Compression
4. Click “Run”
ii. In original folder
1. Delete original, uncompressed TIFFs
2. Move new, compressed TIFFs out of “TIFF” folder to appropriate location (e.g. folder001)
3. Delete empty “TIFF” folder
c. Image enhancement in Photoshop

Though rarely necessary, certain images require minimal editing in Photoshop to enhance clarity. This is most
commonly the case with microfilm frames which are very dark or very bright as to make them almost illegible.
Adjusting the brightness and contrast levels of these images takes minimal effort and makes them easier to read.

d. PDF creation (Acrobat Pro)

Once TIFF images have been compressed, the PS combines and converts them into optimized 100 ppi

PDF/A-1b compliant files. The workflow is as follows.

i. Edit>Preferences—>Convert to PDF>TIFF->Edit Settings>Compression

Note: This setting is retained by Acrobat Pro and does not need to be modified with each session.

1. Grayscale: ZIP
2. Color: ZIP

ii. Create—>Combine Files into a Single PDF
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1. File Size (page icons lower right corner): Larger Files Size (largest icon)
2. Add TIFF files
3. Click “Combine Files”
iii. File->Save As—>Optimized PDF
(Message: 'The PDF document needs to be saved before it can be optimized")
1. Click Yes
2. Name the file following the naming convention (this version will be overwritten by the optimized
file)

3. Click Save
iv. Inthe PDF Optimizer window
1. Settings: 100dpi-jpegmax
Or create the 100dpi-jpegmax preset for next time:
Settings: Custom
Make compatible with: Acrobat 5.0 and later
Images > Image Settings
Color Images:
Downsample: Bicubic Downsampling to 100 ppi for images above 100 ppi
Compression: JPEG, Quality: Maximum
Grayscale Images:
Downsample: Bicubic Downsampling to 100 ppi for images above 100 ppi
Compression: JPEG, Quality: Maximum
Save> Save current settings as: 100dpi-jpegmax
2. Click OK
v. Backin the Save Optimized As window,
1. Click Save
2. Click “Yes” to overwrite the uncompressed PDF

5. Uploading & Digital Object creation
a. Transfer PDFs to server
i. Open FileZilla
ii. Click Bookmarks—>ooh-pdf
iii. Enter password
iv. Lower left pane displays locally stored PDFs (...Desktop\OOH PDFs\). Lower right pane displays PDF
storage location on server (/www-base/library/prd/library.bowdoin.edu/htdocs/arch/mss/ooh-pdf)
v. Dragand drop PDFs from hard drive to server.
b. To add links to Archivists’ Toolkit
i. For each file-level record being linked:
1. Create a Digital Object instance (Add Instance > Digital Object)
2. Title

a. Ifthe file unit will have only one Digital Object instance, retain the auto-populated title,
which is identical to the file unit's title.

b. If the file unit will have more than one Digital Object instance, choose a title to
differentiate this one

i. Note that Digital Objects appearing online will sort alphabetically by title
ii. For example, if a file unit has a Digital Object instance for a digitization and one
for transcripts, you should entitle them this way:
1. Digital Surrogates (for the digitizations)
2. Select Transcripts (for the transcripts)

c. Ifafile unit has more than one Digital Object instance, none of them should have a title
that is identical to the file unit title. This means the titles of existing Digital Object
instances may need to be updated when new instances are added.

3. Digital Object ID
a. Enter the name of the digital file. This must be a unique identifier.
b. If Digital Object will have more than one File Version, use file name root



C.

5.
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i. E.g.“M01b01f001” should be Digital Object ID where the file version URIs are
“M01b01f001textmaster” and “M01b01f001textuse”
File Version
a. Add File Versions as necessary. Multiple versions are to be listed for digital objects of the
same format with different use statements (for example, to list both use and master
versions)
b. URI
i. If the Digital Object will be posted online, enter the URL
ii. If the Digital Object will not be posted online, enter the local file path
c. Use Statement
i. Select statement which best applies to the Digital Object being recorded
1. For digitizations and transcripts, use "Text-Service"
ii. Use statements for all file versions within a Digital Object Record should have the
same root since they are all the same format
1. E.g. If one version within a Digital Object Record has the Use Statement
“Text-Service” (the most common one), all other file versions of that
Digital Object should all start with “Text-“
d. EAD Dao Actuate & Show
i. For use versions (most common)
1. Actuate: onRequest
2. Show: new
ii. For master versions
1. Actuate: none
2. Show: none
e. ClickOK
Click OK

Exporting and posting updated finding aid
Once links have been added and saved, export updated finding aid by the following process

i.

1.
2.
3.

S

N

6. Scanner maintenance

a.

Click “Export EAD”
Name the file with the following convention: M091-ead
Check three boxes:

a. Number component levels

b. Suppress components and notes when marked “internal only”

c. Include DAO’s in output
Save to
Open webpage:
Click on “Draft” button and wait while it connects and processes file(s) — a process report will
come up after a minute or so
Check links to make sure change(s) are ok
Then go back to
button & wait until the process completes.

and click on “Live”

Cleaning
i. Epson
1. After each folder and at the end of every shift, students wipe the scanner glass with a clean, dry
cloth.
2. When necessary, PS uses glass cleaner sprayed on a soft cloth to more thoroughly clean scanner
glass
ii. Bookeye
1. Asneeded, cradle will be dry-vacuumed by PS
2. Atthe end of each shift, students wipe down scanner and work area with a soft, dry cloth
3. As needed, PS will clean scanner surfaces (besides the cradle and touchscreen) with glass

cleaner sprayed on a soft cloth
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i. Epson
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1. On the first of every month, PS recalibrates using SilverFast calibration target.

ii. Bookeye

1. PS will perform series of 7 adjustments monthly through web browser scan interface. (See
Bookeye Setup manual for detailed instructions.)

g

o a0 o

White Balance

Auto Focus

Scan Start

DPI Measurement
Laser Check

Gear Correction
Repeat White Balance

2. ICC Profile Update
a. New ICC profiles should be created monthly for best color results.

L.
il.

iil.

Delete any .icm file present on the Desktop

In the large blue Bookeye Reference folder, locate the white envelope and remove
the IT8 target.

Ensure that the Bookeye’s cradle is in its flat position and that the glass platen has
been removed.

iv. Place IT8 Target on Bookeye center with as little skew as possible. Use the laser
line to help straighten the target. (Briefly pressing the power button will cause the
laser line to appear for 10 seconds.)

v. From the Desktop, open the Scan2ICC folder, then the Scan2ICC application. Click
“Run”

vi. In the first window, the subscription number should already be filled in. Leave the

I[P box blank. Click “OK” and again “OK” in the next window.
vii. Click “Scan IT8 Target”

viii. When an image of the target appears in a new window, place the red marquee
around the target. Use the arrow buttons to zoom in or out as necessary. Click
“Extract” then “OK”

ix. Select batch number R130810 from the list (this is the batch number listed on the
IT8 target)

x. Save .icm file to Desktop.
xi. In Firefox, load the Bookeye’s web browser scan interface , under “Setup” at the
Poweruser level.
xii. Click “ICC profiles”
xiii. Nextto “AdobeRGB” click “Browse”
xiv. Load .icm file that was just saved to the Desktop
xv. Click “Send File”

b. Freeflow note: In order to take advantage of updated ICC profiles, all scans must have the
color space setting on “AdobeRGB” under Setup.



Project timeline

MONTHLY WORK (3-year project)
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Year One:
Month Plan Notes Actual numbers & new goals
[One month| Recruit and hire Proj. Mgr.
prior]
Month 1 Draft procedures
manual Procure office
equipment Procure
planetary scanner
Hire and train student
scanners
Review papers, scan items, perform g.c.,
combine files, and create links
Month 2-3 | Review papers, scan items, perform g.c.,
combine files, and create links
Create "About the Project” Web page
Month4 Conduct formal 3-month performance review
of
Proj. Mgr.
Review papers, scan items, perform g.c.,
combine files, and create links
Month 5-6 | Review papers, scan items, perform g.c., 6-month 50,010 scans completed
combine flies, and create links production goal:
19,650 scans
completed
Month 7 Conduct formal 6-month performance review
of
Proj. Mgr.
Convene focus group to critique results to
date Produce formal 6-month progress
report Engage LYRASIS to digitize
microfilm
Review papers, scan items, perform g.c.,
combine files, and create links
Month 8-12 | Review papers, scan items, perform g.c., 12-month 78,520 scans completed
combine files, and create links production goal:
39,300 scans
completed(+
30,260
microfil
m
scans
comple
ted)

Year Two:
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Month 1 Produce formal to-date progress report
Review papers, scan items, perform g.c.,
combine files, and create links
Month 2-6 | Review papers, scan items, perform g.c., 18-month production 111,098 scans completed
combine flies, and create links goal:
58,950 scans completed
Month 7 Conduct formal annual performance review of
Proj. Mgr.
Produce formal to-date progress report
Review papers, scan items, perform g.c.,
combine files, and create links
Month 8-12 | Review papers, scan items, perform g.c., 24-month production 161,700 scans completed
combine files, and create links goal: (including 31,232 microfilm scans)
78,600 scans completed
Year Three:
Month 1 Produce formal to-date progress report
Review papers, scan items, perform g.c.,
combine files, and create links
Month2-6 Review papers, scan items, perform g.c., 30-month production 175,059 scans completed
combine files, and create links goal: (including 31,232 microfilm scans)
98,250 scans completed
Month 7 Conduct formal annual performance review of
Proj. Mgt.
Produce formal to-date progress report
Convene focus group to critique results to
date Review papers, scan items, perform g.c.,
combine files, and create links
Month8-11 | Review papers, scan items, perform g.c.,
combine files, and create links
Month 12 Review papers, scan items, perform g.c., 36-month 176,235 scans completed
combine files, and create links production goal: (including 31,232 microfilm
Complete final report 117,940 scans scans)
completed(+ plus
30,260 microfilm
scans completed) =
148,200 scans
completed






